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APPLICATION GUIDE

3D Printing Rigid Insole Shells 
Using Fuse 1+ 30W and 
Nylon 11 Powder
Learn how to produce strong, ductile insole shells exceeding 4 million bend cycles with 
Formlabs’ compact, affordable SLS ecosystem. Equipped with unmatched ease of use and the 
lowest CapEx in the industry, Fuse 1+ 30W empowers you to start 3D printing nylon 11 insole 
shells quickly and scalably. Whether you’re taking your first step into digital production or are 
looking to streamline an existing workflow, this comprehensive guide will help you hit the ground 
running with insole shell production on the Fuse 1+ 30W. 

https://formlabs.com/industries/medical/
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Essentials
Required Hardware and Materials

Made by Formlabs Made by Third Parties

•	 Fuse 1+ 30W
•	 Fuse Sift
•	 Nylon 11 Powder

•	 Material overview available here
•	 Powder Cartridge
•	 Build Chamber
•	 PreForm

•	 Scanner
•	 CAD software
•	 Nitrogen source

•	 Generator, compressor, bottle, dewar, or tank
•	 Vacuum
•	 Media blaster
•	 PPE

Introduction
An insole is an orthotic device that is used to help correct or support patients with abnormal foot 
posture. Here, we present a workflow for designing and producing a custom insole shell – a 
critical component of the finished insole – using a 3D scanner, a Fuse 1+ 30W SLS 3D printer 
equipped with an inert atmospheric control, and Nylon 11 Powder.

Important Note:  Achieving the full range of benefits outlined in this application guide relies on 
the use of an inert atmospheric control (nitrogen atmosphere) to effectively eliminate air from the 
build chamber and prevent SLS powder oxidation. Please note that failure to incorporate these 
controls may lead to compromised performance of the printed parts.

https://formlabs.com/store/3d-printers/fuse-1-plus-build-your-own-package/
https://formlabs.com/store/post-processing/fuse-sift-package-120v/
https://formlabs.com/store/materials/nylon-11-powder/
https://support.formlabs.com/s/article/Using-Nylon-11?language=en_US
https://formlabs.com/store/accessories/fuse-1-powder-cartridge/
https://formlabs.com/store/accessories/fuse-1-build-chamber-120v/
https://formlabs.com/software/#preform
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Workflow

1.	 Scan
The digital workflow begins with a scan of a foot. The increasing adoption of digital scanning in 
podiatry has led to the development of fast, accurate scanners that don’t require extensive CAD 
knowledge to use.

Scans are most often taken directly of the patient, but in some instances, it may be desirable to 
take a traditional plaster or foam cast of the patient and scan that model instead. The chosen 
scanning method and device must both be compatible with the CAD software being used for 
design. Most scanners for this application come in one of these four formats; iPhone/LIDAR-
based, handheld, pressure plate, or gait scanner. More information on choosing the best scanner 
for this application can be found here.

2.	 Design

2.1	 Choose a Software
Once a scan of the foot is obtained, specialized software is used to customize the insole to the 
patient’s corrective or accommodative needs. When choosing a software, it is important to look 
for one that offers open .STL, .OBJ, or .3MF file export to ensure compatibility with PreForm, 
and confirm compatibility with the scanning method used. Software packages with proven 
compatibility to PreForm include, but are not limited to, FitFoot360, Gespodo FOOTCAD3D, 
and Amfit. The rest of this section will provide a generalized overview of a process that can be 
expected across many insole design software. 

2.2	 Upload the Patient Scan and Correct the Cast
Upload the patient scan into the design software. If the scan is not already in a neutral position, 
the software may be able to digitally manipulate it into the proper position. Software can also be 
used to clean the model and remove extraneous material that was picked up during the scan. 
A depth map can be used to display high and low points on the model, and the model can be 
edited by removing material, adding material, and smoothing the surface texture of the model.

https://formlabs.com/blog/3d-printed-insoles/
https://fit360ltd.com/FitFoot360.html
https://podo.gespodo.com/en/footcad3d/
https://amfit.com/
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Amfit’s Correct and Confirm Editing Software displaying a depth map and 3D rendering from 
a patient scan.

Patient scan being measured in Gespodo FOOTCAD3D. A full demonstration of this software can 
be found here.

https://amfit.com/
https://podo.gespodo.com/en/footcad3d/
https://vimeo.com/814950782
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2.3	 Select the Insole Type
Select the type of insole you’re looking to create from a menu of different insole types. For this 
overview, we will focus on creating a rigid insole shell for comfort, but these software packages 
offer a variety of different insole types. The software will produce an adjustable .STL, .OBJ, or 
.3MF file for this insole type and display it against the plantar surface of the patient scan. The size 
and position of the whole insole shell, as well as individual features of the insole shell, can be 
adjusted in this step and as needed further along in the design process.

2.4	 Customize the Insole Features
The insole design software will help you adjust features such as the arch depths, heel cup 
thickness, extensions, and flanges against your patient scan. Extrinsic and intrinsic postings can 
be added and adjusted for the forefoot. The same can be added for the heel, as well as heel lift, 
wedge, pitch, skives, and inversion postings. 

The software will help with adding other patient specifications, including forefoot corrections, 
cut-outs, cuboid corrections, indentations, trimmed edges, met pads, relief, and met bars. Some 
users may opt to add a textured surface to the top or bottom of their insole shell to aid with 
slippage or adhesion to other layers.

Screenshot of FitFoot360’s sliding scales being used to adjust the heel posting on a rigid insole shell. 
A full demonstration of this software can be found here.

https://fit360ltd.com/FitFoot360.html
https://www.youtube.com/watch?v=WrbE6pNY1hc
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2.5	 Optimize for Printing

2.5.1	 PLANTAR SURFACE

When printing in the preferred orientation, the device’s minimum thickness on the plantar surface 
should not be less than 1.8 mm in order to maintain the rigidity required to support the user. 
Similarly, thickness should not exceed 3 mm, because increased thickness results in excess 
rigidity, which can lead to premature fracturing under stress.

Diagram showing measurement of the device thickness on the plantar surface.

2.5.2	 FOREFOOT AND EDGES

The forefoot and edges of the insole shell may be thinner than the plantar surface in order 
to create a smooth transition from the hard to soft material in the completed insole assembly. 
Optimal mechanical properties were observed on samples with edges approximately 2 mm thick. 
The printer is capable of unsupported geometry smaller than this if necessary. Care should be 
taken when using media blasting on very thin edges to avoid damage that could propagate into 
a fracture under extreme bending.

2.5.3	 EMBOSSING AND ENGRAVING

You may want to emboss or engrave a company logo or patient identifier on the insole shell. 
The Fuse 1+ 30W is ideal for embossing, engraving, or other fine details included in the insole 
shell design. Some design guidelines for best results are listed below, and more information on 
designing for SLS printing can be found here.

MINIMUM EMBOSSED FEATURES
A

B

B.3 A.3

B.1

A.1

A.4

B.2

A.2

B.4

A. HORIZONTAL FACES:

A.1   Depth: 0.15 mm 

A.2   Width:  0.35 mm 

A.3   Text font height: 4.5 mm 

A.4   Text font depth: 0.3 mm

B. VERTICAL FACES:

B.1   Depth: 0.35 mm 

B.2   Width:  0.4 mm 

B.3   Text font height: 4.5 mm 

B.4   Text font depth: 0.3 mm

Embossed features are extruded from the surface of the model. Small embossed 
features may not be visible on the finished part. Use a bold font where possible for 
best results with embossed text.

https://3d.formlabs.com/fuse-1-sls-design-guide/
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2.6	 Export
Once the design is completed within the CAD software, the file should be exported in .STL, .OBJ, 
or .3MF format.

3.	 Print

3.1	 Select Printer and Material
Ensure you have the latest version of PreForm and printer firmware installed. Open PreForm and 
select Job Setup. Choose the name of the printer that you intend to print on and select 
Nylon 11 Powder from the material menu. The powder used can be a mix of fresh and used 
powder, but should contain a minimum of 30% fresh powder. When printing without an inert 
atmospheric control (nitrogen), use 100% fresh powder to maintain material performance.

3.2	 Import Model File Into PreForm
Click File > Open to import the .STL, .OBJ, or .3MF file that was exported from the design 
software into PreForm. 

3.3	 Orient Models
Printing flat is the best option for optimizing mechanical properties. To print flat, open the 
Orientation tab on the left side of the screen and click Select Base. Place the base so that it is 
normal to the plantar surface of the insole shell, and the part will sit flat.

Some scenarios may call for angled printing. Printing at an angle can be used to achieve longer 
insole lengths and improve packing. Internal testing conducted by Formlabs has shown that 

MINIMUM ENGRAVED FEATURES A

B

B.3 A.3

B.1

A.1

A.4

B.2

A.2

B.4

A. HORIZONTAL FACES:

A.1   Depth: 0.1 mm 

A.2   Width:  0.3 mm 

A.3   Text font height: 3 mm 

A.4   Text font depth: 0.3 mm 

B. VERTICAL FACES:

B.1   Depth: 0.15 mm 

B.2   Width:  0.35 mm 

B.3   Text font height: 3 mm 

B.4   Text font depth: 0.3 mm

Engraved features are cut from the surface of the model. Small engraved features 
may not be visible on the finished part. Use a bold font where possible for best results 
with engraved text.

https://support.formlabs.com/s/article/Install-PreForm-Software?language=en_US
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angling prints in the long axis (heel to toe) can increase the maximum insole shell length without 
a significant compromise in real-world performance. Parts can also be rotated on their long axis 
to improve packing. To angle the rigid insole shell, go to the Orientation tab on the left side of 
Preform. Using the Orient X or Orient Y input fields, enter the desired angle value so that the 
part tilts on its short axis. Printing insoles vertically, i.e., at an angle greater than 50° degrees from 
the build chamber floor, will lead to suboptimal mechanical performance and inefficient build 
chamber use, therefore resulting in a higher cost per part.

Rigid insole shell angled at 50° to the build chamber floor on the short axis (left) and a packed build 
volume, optimized by rotating shells 45° on their long axis (right)

Very long insole shells can be printed diagonally across the build chamber floor, Corner to 
Corner (C2C) on their long edge. To print on the long edge, open the Orientation tab on the left 
side of the screen and click Select Base. Select the long edge of the part so that it appears to 
stand up on its side. Manually rotate the part in the Z direction so that it sits corner-to-corner in 
the build volume. If the insole is still too long diagonally, an additional angle of up to 50° can be 
added between the part and the build chamber floor. Additionally, a part being printed in this 
orientation can be rotated along its long axis to improve packing.

Rigid insole shell being printed corner to corner on its long edge (left) and a shell being printed 
on its long edge 50° from the floor of the build chamber and rotated 40° to improve length 
and packing (right).
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Use the following chart as a guide for angling your prints to achieve prints up to 270 
mm in length.

TOTAL PRINT LENGTH IN MILLIMETERS: Side to Side (S2S) vs Corner to Corner (C2C)

300 mm

250 mm

200 mm

150 mm

Angle

Length (S2S) Length (C2C)

0 ° 5 ° 10 ° 15 ° 20 ° 25 ° 30 ° 35 ° 40 ° 45 ° 50 °

3.4	 Arrange Models
Multiple copies of the same insole shell can be printed using the Array feature. To use the 
Array feature, go to the Layout tab on the left side of the screen, highlight your part, and select 
Array Models. Input the number of times that you would like to duplicate your design and set 
the desired spacing. Be aware that the spacing setting in the array feature measures the space 
between bounding boxes, not actual geometry, so to get curved parts like insoles to sit very 
close to one another, the spacing may need to be set as a negative value. Manual adjustments to 
spacing may be required to maximize the number of printed parts. If parts are spaced too closely 
together, a red outline will appear on the part to indicate that the spacing should be increased.

The Layout tab also allows you to create mirrored parts, which may be desirable for patients 
that require the same device design for both feet. To use the mirror feature, open the Layout tab 
and duplicate the part that needs to be mirrored. Highlight the newly duplicated part and select 
Mirror Models. Rearrange to fit in the build chamber as necessary. 

The number of insole shells that can fit in the build chamber will vary depending on the design. 
More parts can be fit in the build volume by grouping right-foot and left-foot devices together, 
and aligning them at 180° to each other with the straighter edges along the outside of the build 
volume. Additionally, stacking insole shells so that the largest are on the bottom and the smallest 
are on the top, and batching prints by size (i.e., one chamber filled with devices sized men’s US 8 
/ EU 41 and smaller, another chamber with devices size men’s US 8.5 / EU 42 and larger) will help 
fit more in the build volume as well. Representative .FORM files of what an average build volume 
may look like can be downloaded here and here.

https://drive.google.com/file/d/1bCHwx05xMYnrd-YqPJNed3zdkTRqjgd1/view?usp=share_link
https://drive.google.com/file/d/12oSlJFKB3cv_TYJL8w2WoKSlawualw3O/view?usp=drive_link
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The build chamber volume can be maximized by limiting the build to all right-foot models, or 
all left-foot models, at one time. For this reason, high-throughput users may want to consider 
utilizing two printers: one exclusively for right-foot shells, and one exclusively for left-foot shells. 
This will allow the capacity of the build chamber to be maximized while producing right and 
left shells simultaneously.

3.5	 Prepare the Printer 
Add Nylon 11 Powder to the printer using a Fuse Series Powder Cartridge and insert a clean 
optical cassette. Insert a build chamber and follow any other preprint checks prompted by the 
machine. To preserve material performance, make sure you use at least 30% new powder mixed 
with, at most, 70% recycled powder that’s only been used in nitrogen atmospheres. Formlabs 
recommends a refresh rate of 30% new powder with 70% recycled powder to minimize waste 
and production costs.

3.6	 Prepare the Nitrogen Supply 
Nitrogen is essential to producing optimal mechanical properties for insole shells when using 
recycled power. Once installed, the nitrogen system is relatively passive, requiring very little 
attention during normal operation. Nitrogen can be provided from any source that meets 
the following specs: concentration of 99.5% or greater, flow of 0.5 SCFM, pressure range 
within 36-120 psi, and a gas temperature at the machine inlet of 18°C (64.4°F) or more. This 
calculator by Airgas can be used to figure out your Fuse 1+ 30W’s nitrogen demand, and your 
recommended supply mode.

The Fuse 1+ 30W will notify the user if the system is 
performing outside of parameters, however manually 
checking that the printer is receiving nitrogen is possible 
by accessing the printer status screen, toggling Nitrogen 
System to ON, and checking that the touch screen 
says N2 Mode.

3.7	 Upload the Print
In PreForm, click the orange print button on the right side 
of the screen to upload your print to your selected printer.

Note: For more information on the role that 
Nitrogen plays in the Fuse 1+ 30W workflow, read 
this blog post.

https://www.airgas.com/formlabs-gas-calculator
https://www.airgas.com/formlabs-gas-calculator
https://formlabs.com/blog/inert-atmospheric-control-refresh-rate-insole-shells/
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4.	 Post-Process

4.1	 Cool the Print
The cooling process starts within the print enclosure. Once printing is complete, the build 
chamber remains in the printer for 75 minutes. After the initial 75 minutes of cooling inside the 
printer, the build chamber can be removed from the printer and placed either in Fuse Sift or 
on the floor so that another print can be started. The build chamber will then continue to cool 
outside of the printer for the amount of time suggested by PreForm next to Chamber Cooling. 
If the build chamber is cooling in the Sift, the Sift will stop displaying the “hot build chamber” 
warning screen when cooling is complete.

4.2	 Extract Parts Using Fuse Sift
Use the touchscreen to turn on the Fuse Sift’s light, and then the sifter. Raise the print bed, either 
a little at a time or all at once, to eject the cake. Use the wire brushes and picks provided to 
scrub unsintered powder from the fused parts. Clean up excess powder into the sifter so that it 
may be recycled. Do not share the same Fuse Sift for parts that were printed with nitrogen and 
without nitrogen. This will lead powder cartridges to become filled with a mix of oxidized and 
non-oxidized powder, which can result in mechanical property variability across the build volume 
for your next print. 

4.3	 Media Blast
Use a media blaster with glass media to do a final clean and smooth of the finished parts. Some 
lower-cost media blasters that are suitable for Nylon 11 Powder include Fastenal, Grainger, 
and McMaster-Carr. Additional recommended media blasters can be found sorted by region 
on this page.

5.	 Complete the Insole Assembly
Once the insole shell has been 3D printed and post-processed, additional layers of softer 
material can be added to create the whole insole. The exact materials added depend on the 
patient’s need and the designer’s preference. Oftentimes, a leather, silicone, neoprene, or foam 
layer is added above and below the rigid shell for cushioning, slippage prevention, and moisture 
control. Ensure that any adhesives used to add additional layers to the Nylon 11 Powder Shell are 
compatible with the material according to the technical data sheet, and biocompatible.

The insole is ready for delivery to the healthcare professional or patient.

https://www.fastenal.com/product/details/0829155
https://www.grainger.com/product/ECONOLINE-Abrasive-Blast-Cabinet-33-3Z848
https://www.mcmaster.com/3464K11/
https://support.formlabs.com/s/article/Formlabs-approved-distributors-for-supplies-SLS?language=en_US
https://formlabs-media.formlabs.com/datasheets/2101560-TDS-ENUS-0.pdf
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6.	 Modify
After observing the patient and collecting feedback, the healthcare provider may choose to 
make additional modifications to the insole shell. The Nylon 11 Powder insole shell may be 
modified with the addition of padding and extensions that may be off-the-shelf or printed with 
Formlabs TPU 90A Powder material on a dedicated machine. (Note: do not use the same Fuse 1+ 
30W printer for both Nylon 11 Powder and TPU 90A Powder). 

If necessary, hand tools that the provider already has in-office can be used to remove material or 
add texture to increase adhesion to other layers or minimize slippage. The material can also be 
thermoformed by hand using a heat gun. For increased rigidity and glossy appearance, insole 
shells can be vapor smoothed. Note that this may result in decreased flexibility.  

Biocompatibility
Nylon 11 Powder has been evaluated in accordance with ISO 10993-1. It is certified for skin contact 
(ISO 10993-10), non cytotoxic (ISO 10993-5), and a non-irritant or sensitizer (ISO 10993-10). More 
information on the compatibility of Nylon 11 Powder can be found on the technical data sheet.

Limitations

1.	 Material
The only suitable material for this application currently offered by Formlabs is Nylon 11 Powder. 

2.	 Orientation
Printing orientations other than those highlighted above can lead to suboptimal mechanical 
properties if the insole is not reinforced with additional material.  

3.	 Build Volume
The build volume of the Fuse 1+ 30W build chamber is 165 x 165 x 300 mm.

https://formlabs.com/store/tpu-90a-powder/
https://formlabs-media.formlabs.com/datasheets/2101560-TDS-ENUS-0.pdf


North America Sales Inquiries 
sales@formlabs.com
617-702-8476
formlabs.com

Europe Sales Inquiries 
eu-sales@formlabs.com 
+44 330 027 0040
formlabs.com/eu

International Sales Inquiries
Find a reseller in your region:
formlabs.com/find-a-reseller

Get Started With 3D Printed Insoles
Explore our webpage about 3D printing insoles for a detailed workflow video, case studies, 
mechanical performance analysis,  and more.

Learn More About 3D Printing Insoles

Do you have any questions about 3D printing insoles or Formlabs’ 3D printing solutions? Get in 
touch with our medical expert team directly.

Contact Our Experts

mailto:sales%40formlabs.com?subject=
http://www.formlabs.com
mailto:eu-sales%40formlabs.com?subject=
http://www.formlabs.com/eu
http://www.formlabs.com/find-a-reseller
https://formlabs.com/industries/medical/medical-devices/orthotic-insoles/
https://3d.formlabs.com/contact-medical-sales/
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